OPERATION MANUAL

DIGIVISION
Torque

Manufacturer:
© 2023 burster burster
prazisionsmesstechnik gmbh & co kg prazisionsmesstechnik gmbh & co kg
All rights reserved Talstrasse 1 -5 Postfach 1432
76593 Gernsbach 76587 Gernsbach
Germany Germany

Valid from:  September 14, 2023 Tel.: +49 7224 645-0
Fax: +49 7224 645-88
Email: info@burster.de
www.burster.de

4453-BADIGIVISIONDMDE-5999-111534



DIGIVISION DREHMOMENT

Warranty disclaimer

All information in the present documentation was prepared and compiled with great care and reproduced
in accordance with effective control measures. No warranty is provided for freedom from errors. We
reserve the right to make technical changes. The present information as well as the corresponding
technical data can change without notice. Reproduction of any part of this documentation or its
processing or revision using electronic systems is prohibited without the manufacturer’s prior written
approval.

Components, devices and measurement sensors made by burster prazisionsmesstechnik (hereinafter
referred to as the “product”) are the result of targeted development and meticulous research. From the
date of delivery, burster provides a warranty for the proper condition and functioning of these products
covering material and production defects for the period specified in the warranty document accompanying
the product. However, burster waives any guarantee or warranty obligations or any additional liability for
consequential damages caused by improper use of the product, in particular the implied guarantee of
success in the market as well as the suitability of the product for a particular purpose. Furthermore,
burster assumes no liability for direct, indirect or incidental damages or for consequential or other
damages arising from the provision and use of the present documentation.
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1 Symbols used in the operation manual

1.1 Signal words

The following signal words are used in the operation manual according to the specified hazard
classification.

DANGER

High degree of risk: indicates a hazardous situation which, if not avoided, will result in death or
serious injury.

/N WARNING

Moderate degree of risk: indicates a hazardous situation which, if not avoided, may result in death or
serious injury.

/\ CAUTION

Low degree of risk: indicates a hazardous situation which, if not avoided, could result in minor or
moderate injury.

NOTICE

Note: Itis important to heed these safety notices in order to ensure correct handling of the sensors.

IMPORTANT:  Follow the information given in the operation manual.

1.2 Pictograms

A Electric shock hazard.

' Observe the advice for protecting the instrument.
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2 Introduction

IMPORTANT: Read the operation manual carefully before using the equipment, and keep it for future
reference.

2.1 Intended use

The DigiVision software can be used to configure various burster sensors and devices, and to carry out
measurements. This operation manual relates exclusively to torque sensors. If using other sensors or
devices, please refer to the respective operation manual.

2.2 Customer service

2.21 Customer service department

If you have repair inquiries or software problems, please call our customer service department on
+49 7224 645-53.

2.2.2 Contact person

If you have any questions, please contact your representative or go directly to burster
prazisionsmesstechnik gmbh & co. kg.

Headquarters

burster prazisionsmesstechnik
gmbh & co kg

Talstrasse 1-5

76593 Gernsbach

Germany

Phone: +49 7224 645-0
Fax: +49 7224 645-88
Email: info@burster.de
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3 Non-rotating torque sensors, model
8625/8630/8631, USB version

3.1 Electrical connection

The USB socket is supplied with a protective dust cap fitted. Before putting the sensor
into use, this cap must be levered off, without damaging it. It is not meant to be cut off!

=5\
Mhis is how it works

1. Take the cap off the USB socket.

2. Connect the torque sensor to a computer using the supplied USB cable.

3. Please be sure to follow the instructions in section 3.2 Power supply on page 7.

3.2 Power supply

The device draws 200 mA from the USB port. Usually this is not a problem for desktop PCs.

For laptops, however, several USB ports may share one power supply that is additionally loaded by other
connected USB devices (mouse etc.) Therefore, under some circumstances, the torque sensor may be
supplied with too little power and cannot register its presence. In this case, you need to connect the
torque sensor to the laptop via an active USB hub.
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3.3 Connector pin-out

The USB interface complies with the USB 2.0 standard and the pin assignment is as usual. The built-in
connector on the torque sensor is for a “Micro USB” plug.

Pin Name

1 5V

Data -

=885~ g

2
R Lk ) |
: )

ID (not used)

5 GND Figure 1:  Micro USB [mm]

The connector fitted on the supplied cable is a “USB Type A” plug.

-— 1200 —

Pin Name

Figure 2:  USB A [mm]

3.4 Ground connection

The common ground connection “Digital Ground GND” is shared by:
e USB plug casing
e Shield
e Sensor housing

e Protective ground
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torque )
micro- - -~
processor
5V output USB
Pan Y
J/
voltage-
transformer
7\
b
Notice: The case has to be I

connected to protective earth
Figure 3:  Ground connection

3.5 Running cables

In general the following applies:
¢ The torque sensor must be grounded via its mounting screws.

e The USB cable length should not exceed 2 m. For longer cables it may be necessary to
connect an active USB hub in the cable link to avoid losing the USB connection.
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4 Rotating torque sensors, model 8655/8656/8661,
USB version

4.1 Electrical connection

The USB socket is supplied with a protective dust cap fitted. Before putting the sensor into use, this cap
must be levered off with a suitable tool, without damaging it. It is not meant to be cut off!

.

Mhis is how it works

1. Carefully prise off the protective cap using a pointed tool.

2. Take the cap off the USB socket.

Connect the torque sensor to a computer using the supplied USB cable.
Please be sure to follow the instructions in section 3.2 Power supply on page 7.

The torque sensor goes through a self-test mode lasting 4 seconds after power-up.
Once the self-test has finished, all the LEDs — if fitted — light up solidly for about 1 s.
Then the sensor is ready for operation.
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4.2 Power supply

After the torque sensor is connected to the USB port, the sensor identifies itself as a “high power device”.
In this case, the device draws 495 mA from the USB port. Usually this is not a problem for desktop PCs.

For laptops, however, several USB ports may share one power supply that is additionally loaded by other
connected USB devices (mouse etc.) Therefore, under some circumstances, the torque sensor may be
supplied with too little power and cannot register its presence. In this case, you need to connect the
torque sensor to the laptop via an active USB hub.

Note: The actual power consumptionis: P=5V *0.35 A =1.75 VA.

4.3 Connector pin-out

The USB interface complies with the USB 2.0 standard and the pin assignment is as usual. The built-in
connector on the torque sensor is a “USB Mini B” plug.

Pin Name

1 5V |~—6.80 —|

2 Data - A
3.00

3 Data + Y

4 ID (not used)

5 GND Figure 4:  USB Mini B [mm]

The connector fitted on the supplied cable is a “USB Type A” plug.

Pin Name

2 Data -

3 Data + [ e — 4.50
4 GND

Figure 5: USB A [mm]

4.4 Ground connection

The common ground connection “Digital Ground GND” is shared by:
e USB plug casing
e Shield
e Sensor housing

e Protective ground
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5V
max. 2 W
torque )
micro- - -
processor
5V output USB
Pan
WV
Y
voltage-
speed transformer
angular
displacement
opto encoder
with
encoder disc
'
-
Notice: The case has to be I

connected to protective earth

Figure 6:  Ground connection

4.5 Running cables

In general the following applies:
e The torque sensor must be grounded via its mounting screws.

e The USB cable length should not exceed 2 m. For longer cables it may be necessary to
connect an active USB hub in the cable link to avoid losing the USB connection.
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5 DigiVision software

5.1 Device list / Device detection

3
{ & This is how it works

1. Open DigiVision.

2. Go to “File” > “Find devices...".

Ml pigivision - a x
File | Edit Measure Special 7
Create new device parameters (offline)... Strg+N
r Station name Mode
Import parameters from file (offling)... Strg+ O
L ' ' = ME) add Find
Import parameters from device (onlin)... no party
Dewnload (device -» backup file) Strg+D 130 Kommentarfeld_Geraet
Upload (backup file -» device) Strg+U
Download all listed devices into a backup file for each device
Upload from a backup file to all listed devices
Print parameters >
Find devices...
Device list s
Close Strg+Q)
Miscelansons Properties Download Find Test
|1 pertls) - with a tetal of 1 device(s) in the device list. | Logged on as: MasterName (Master) _:

3. As soon as the torque sensor has been detected, it is displayed under the associated
port.

Ml Digivision - m] ®

File Edit Measure Special 7
Settings Type Address Serial number Station name Mode

D —— COME USB Serial Port (COME)
Eac oy Parameters | 15300, & data bis - 1 stap bis - no party Add Find
Backup
SN_457430 Kommentarfeld_Geraet
Print reports
Wsasure
»

Start measurement

Find and manage
measurement repats...

Miscelancaus Properties Parameterization Download Find Test

|1 pert(s) - with a total of 1 device(s) in the device list. Logged on as: MasterName (Master) .:

5.2 Device settings

You can access the “Device settings” menu from the DigiVision device list.
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1. Open the device list in DigiVision.

2. Select the torque sensor and click “Parameterization”.

Ml Digivision - m] X

File Edit Measure Special ?

Settings Tvpe Address Serial number Station name Mode ‘
s oM 453 St o oM R
gnoetongn Parameters 115200, & data bit - 1 stop bits -no party =
Backup
SN_457430 Kommentarfeld_Geraet
Print reports
Measure

Start measurement
mode

Find and manage
measurement reports

Miscelangous Properties i Dawnload || Find | Test
e——

| 1 port(s) - with a total of 1 device(s) in the device list. Logged on as: MasterName (Master)  .:

3. You can now configure the sensor-specific settings.
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5.3 Setup

5.3.1 Setting up rotating sensors

On the “Settings” tab, you can specify the units and conversion factors to be used for the relevant
measurement channels. Units suitable for the measured variable should be selected, otherwise errors
may occur when displaying the measured value and in its interpretation.

With “Number of Averages” you can set the number of individual measured values to be used to form an
arithmetic mean. The value can be set in the range N =1 to N = 20. When N = 1, averaging is not
performed. In this case, the value at the output is refreshed every 10 us. This corresponds to 100 000
digitizations per second. So if you select N = 20, for example, then a measuring time of 200 ys is needed
for a new value at the output (20 x 10 = 200 ps). The averaging has a direct effect on the measured
values per second. The higher the averaging value, the fewer measured values per second are possible.

If the torque sensor includes the speed/angle measurement option, you can switch between these two
measurement modes on this tab.

If the torque sensor is the optional dual-range version, you can also select the required measurement
range here. Applying the settings saves them in the sensor.

Settings Limits  Properties

Angle mode O
Averaging
Speed mode - 10 =
Channels
Decimal places Unit Conversation factor
Torgue 0.00 ~ |Nm ~ | | 1 |
Speed 0.0 w | 1/min i | | 1 |
Angle i} Einh_Winlkd 1
Power 0.0 vl |w vl 1 |
big 1/1

Save Transfer

Figure 7:  Settings for rotating sensors
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5.3.2 Setting up non-rotating sensors

On the “Settings” tab, you can specify the units and conversion factors to be used for the relevant
measurement channels. It is important to select units that make sense and are suitable for the measured
variables, otherwise errors may occur when displaying the measured value.

With “Number of Averages” you can set the number of individual measured values to be used to form an
arithmetic mean. The value can be set in the range N = 1 to N = 50 000. When N = 1, averaging is not
performed. In this case, the voltage value at the output is refreshed every 10 ps. This corresponds to
100 000 digitizations per second. So if you select N = 50 000, for example, then a measuring time of

5 seconds is needed for a new voltage value at the output (50 000 x 10 = 0,5 s). The averaging has a
direct effect on the measured values per second. The higher the averaging value, the fewer measured
values per second are possible.

Disable the low-pass filter if you set a value N # 1.
Filter settings: Set the averaging value to N = 1 if you select a cut-off frequency # OFF.
The low-pass filter is a digital filter designed as a first-order low-pass filter.

Apart from the “OFF” setting, you can select various cut-off frequencies. The cut-off frequency is the
frequency at which the output signal is attenuated by -3 dB, corresponding to about 70.7 % of the signal
at very low frequencies.

If the torque sensor is the optional dual-range version, you can also select the required measurement
range here, or activate switching by a voltage level.

Applying the settings saves them in the sensor.

Settings  Limits ~ Properties

Properties

Averaging Upper range value Filter:

: o -
Channels

Decimal places Unit Conversation factor

Torgue 0.00 e Mm v| |1

Multiregion sensor

Range Measurement range

Print Parameter Save Transfer Cancel

Figure 8:  Settings for non-rotating sensors
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5.4 Limits

The “Limits” tab is where you can set the sensor limits you require. Select the level for the limit, the
channel reference for this limit and whether you wish to monitor the measurement signal for = or <.

Settings  Limits  Properties
Setpoints

Setpoint Channel reference

1,00 5 Taorgue
2,00 -5 Torque
3,00 -5 Torque

4,00 15 Torgue

5.5 Properties

Save

Figure 9:

Mode

off

off

off

off

Transfer

Limits

The “Properties” tab contains information about the torque sensor being used. This is where you can find
the software version, device type, serial number, device option and calibration date. You can also add

comments for documentation purposes.
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Settings  Limits =~ Properties

Properties of device parameters

Present source: Online from a device.
Original source: Online from a device,
Created on: 02.08.23 10:10:32

Device properties

Device name Serial number

| | (sN_480530 |
Software version Calibration date

|van1s00 | [12.10.17 |
Unit type Option

|8630—501[J—V00100 | |2—Region |

Description of device parameters (only for documentation)

T | [T ] [ | (@)

Figure 10: Properties
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6 Properties, measurement rate etc.

You can use the “Properties” button to make additional general settings. For instance you can set the
measurement rate for the torque sensor here.

Y,
Mhis is how it works

1. Open the device list in DigiVision.

2. Select the torque sensor and click “Properties”.

Ml pigivision - m} x
File Edit Measure Special 7
Settings Type Address Serial number Station name Mode
Devi rfigurat COM10 USB Serial Port (COM10)
Svice comiguEten s 115200, 8 data bis - 1 siop bits -no pariy Add Find
Backup
’ Ba61 a SM_418024 418024
Print reports
Measure COM11 USB Serial Pert (COM11) N
Fendts 521600, 8 data bis - 1 stop bits - na party Add Find
»
Start measurement 'g 8630 0 SN_480590
mode. .
Find and manage
measurement reports...
Miscellaneous Properties arameterization Download Find Test

3. You can now configure additional general settings.

6.1 General settings

| 2 port(s) - with a total of 2 device(s) in the device list.

Logged on as: MasterName (Master) .:

The “General information” tab contains general information about the torque sensor being used. You can
also enter a station name for the torque sensor, i.e. a name identifying the device.
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' Properties for 'Station ' Type '8630" [SN_420550)

General information  Measurement mode

Identification

Station name
Calibration date
Software version
Serial number

Device version
Communications option

MNumber of channels

121007
V201300
SN_430530
8630-5010-V00100
LUSB_MEAS

1

[ ok ]| canca

| [@]

Figure 11: General settings
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6.2 Measurement mode and data acquisition

Different measurement rates (sampling rates) can be selected. The maximum number of
measurements/second is determined by the number of averages and the license.

. Properties for 'Station ' Type '8630° (SN_420390) *

General information  Measurement mode

Measurement-mode data acquisition

Options
Agquesition data Measurement value w
Measurements/s 10 w
MNote: The max. Number of readings/sec is derived from the
number of mean values (currently 5) and a valid license!
Unit torque Mm () Manual (®) From the device

Figure 12: Measurement mode data acquisition for non-rotating sensors

. Properties for 'Station 418024' Type '8661" (SN_418024) >

General infformation  Measurement mode

Measurement-mode data acquisition

Options
Aquesition data Measurementy, -~ Angle display 0-380 ~
Measurements /s -
MNote: The max. Mumber of readings/sec is derived from the
number of mean values {currently 10) and a valid license!
Unit torque Mm () Manual (®) From the device
Unit speed 1fmin () Manual (®) From the device
Unit angle Einh_Winkl Manual From the device
Unit power w () Manual (®) From the device

Figure 13: Selecting the measurement rate and acquisition mode for rotating sensors

21 of 39



DIGIVISION DREHMOMENT

Two different acquisition modes are available. Different measurement rates (sampling rates) can be
selected depending on the acquisition mode.

Normal

Measurement rates of between 0.1 and 20 measurements per second are possible here.
SPOM (Speed optimized POIlling Mode), only available with model 8661

Measurement rates of between 0.1 and 1000 measurements per second are possible here.
Angle display (only available with rotating sensors)

The “Measurement mode” tab also lets you set how you want to display the (optional) angle reading: from
0 to 360° or continuously without limit.

6.3 Measurement mode settings

In DigiVision, numerous different settings can be made for the measurements. You can access the
Settings menu directly from the “Measurement mode” function.

— &3
Mhis is how it works

1. Open DigiVision.

2. Select the “Start measurement mode ...” item in the device overview.

Ml pigivision - m} X
File Edit Measure Special 7
Settings Type Address Serial number Station name Mode
D S = COM10 USB Serial Port {COM10)
S Parameters | 115200, B data bits - 1 stop bits -no party Add Find
Backup
’ 8661 1] SN_418024 418024
Print reparts
Measure COM11 USB Serial Port {COM11)
— Parameters | 531630, B data bits - 1 stop bits -no party Add Find
3
Start measurement
mode...
s
Find and manage
measurement repors...
Miscellancous Properties Parameterization Download Find Test
|F_ port(s) - with a total of 2 device(s) in the device list. | Logged on as: MasterName (Master)  .:

3. Press the “Options” button. This opens the “Basic configuration” window.
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M Mezsurement mode O X
Muti-channe! display
8651 | 418024 - M 12 T T T T T X
R Max - - w0 F ]
R | Min 0¥ E
05 + E
T  Tare 0,00 [ES E
0z % 3
00 + + + + t
0 5 i 15 20 25 30
Full screen | View ~ | Zoom » | Actions + | Messured values 0 | Samples/sec (target): 20 - | Samplefs 0 | Er 0|
651 418024 -1, 12 : : : : T x
Mezsured vahe R | Max -- 10 £ 3
R Min -- oEF E
05+ E
T Tare 0,0 04 ¥ 3
LEXES E
00 + + + + t
0 5 0 15 20 25 20
Full screen | View v | Zoom v | Actions = | Measured values 0 | Samplesfsec (targat): 20 | samplefs o [ Er 0|
8661 | 418024 - P 12 T T T T T x
Messured vals R Max -- wi El
R Min -- 0F £ E
05+ 3
T Tare 0,0 e B 3
LEXS 3
0.2 + + + + t
0 5 0 15 20 25 20
Fullscreen | View ~ | Zoom v | Actions = | Messured values 0 | Samplesfsec (target): 20 | samplefs 0| Er 0|
Device selection »> Reset [F6] | | Tara [F7] b F| (@[5 W

State: Measurement not active... |

6.4 Basic configuration

.
lI=-L

On the “Basic configuration” tab, you can specify how many channels you wish to display. You can also

make various settings here for the display and presentation of the measurement curve.

. Measurement-mode settings

Basic configuration  Channel settings  Trigger Documertation  Mathematics

Measurement mode
(® Continuous mode () Single mode

Display [ Superimpose measurement curves in one araph

(O 1<hannel D () 2<channel m () 2<hannel E ® 3channel

| —— —r—] |
() 4channel ,,:IE () &channel ,’:": () 8<channel Er': () 16-channel —-—

{— ol

Il

q

(O 32channel

Mizcellaneous settings

%-axis label () system tme (@) Elapsed time () Mumber of measurements
[ show urits Show station name Show axis scale
Graph refresh time (s) 0,25 ~ Standard channel view |Graphic and values w
Visible time window (s) [ %-Auto scaling 30 $

Lines

Min-Max Reference cursor Reference point A Reference pointB  Lim.1  Lim.2 Lm.3 Lim.4
Line
Color | Thidmess |1 % Display [] Type |Dot ~

Figure 14: Basic configuration

>
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DIGIVISION DREHMOMENT

The “Channel settings” tab is where you can set specific parameters for each measurement channel.

. Measurement-mode settings

Basic configuration Channel settings  Trigger Documertation Mathematics

1

2|3

Device [ Device channel

Station name

Device type 8651

Miscellaneous settings

View
Zoom/Scale
® Automatic () Manual
() From the device
Limits / limit values
(® Manual
Limit 1
() From the device
Limit 2
Limit 3
Lirnit 4
Line
Color [l Thickness |1 %
Symbol
Color [ Thickness |1 5

418024 (0 SN_418024)

Channel no M

Graphic and values

Min 0,00

off | [1,00
off | [2,00
off | [3,00

off ~| [4,00

Display

Display []

Type

Type

X

Delete Assign
Configuration
Max (0,00 o
Active  Inactiv
Color | [
Color | [
Color | [
Color | [
Solid ~
Square ~

Figure 15: Channel settings

The default setting is to adopt the parameters from the torque sensor, although you can also make
manual changes to any parameter. Here you can also define the limits, measurement curve colors and
the colors and shapes of the symbols that can be shown in the graphs. You have to make these settings
separately for each measurement channel.

6.6 Trigger

Measurement can also be stopped using a trigger with a suitable stop condition.
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. Measurement-mode settings bt

Basic corfiguration Channel settings  Trigger  Documentation  Mathematics

Measurement repetition after time interval
5 Tl s

Conrfiguration
[ Start measurement for all channels

(@ Alchannels () Channel+elated [] Completely finish measurement

All channels

Start-trigger setting
[ Trigger automatically after set time [ Threshold value

02.08.23 1n24:27 = 3,50000 =

Stop-trigger setting
1 Mumber of meas. [ buration [ Threshold value
5 = 0,20 = o= 5,00000 =

Recording in a range

[ »=min value  |0,00000 = [J <=maxvale  |0,00000 =

Cance
Figure 16: Trigger settings

6.6.1 Repeat measurement after time interval

You can use the “Repeat measurement after time interval” setting to specify a time interval after which a
repeat measurement shall take place following the end of a measurement process. You can configure the
settings to apply to all channels or each channel individually.

6.6.2 Start-trigger setting

Here you can define the start condition.

6.6.3 Stop-trigger setting

Here you can define the stop condition.

6.6.4 Recording in arange

You can use this setting to specify the range of values within which a measurement shall take place.

6.7 Documentation

Various documentation settings are available here. For instance you can define various counter settings,
which can be common to all channels or apply to specific channels. You can also enable/disable the
documentation setting.
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. Measurement-mode settings *

Basic corfiguration  Channel settings  Trigger Documentation  Mathematics

Configuration
® Al channels (O Channel-related
All channels
Enabled
Compaonent Batch
| | Day counter v
Comment Specify name manually

Parts SN
Counter

Running counter per batch w
last parts SN
00001

%1 nextcounter number %2
| | [poooz_|| |

=

Figure 17: Documentation settings

6.8 Display
The measurement curves are displayed in a line graph separately for each measurement channel. The
measured values are plotted against measurement time in this graph.

You have various zoom and display options available to gain a better view. For instance you can
show/hide measurement channels.

Maximum and minimum values (Max, Min) are shown in the area to the left of the graph. You can reset
these values using the “R” buttons.

The “T” button tares the current value; the tare value is displayed next to the button. Pressing the button
again clears the value.
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Mutti-channel display

8651 | 418024 - M 003 T T T T T T X
Messured vahe R Max 0,04 0.04
0.03
R Min -0'[]1 0,02
0,03 Nm e
o.oo
1 4 T  Tare (,00 -
-0.01
-0.02
Lim.1 008 t t t t t t
. 1’00 135 140 145 150 155 160
Full screen | View ~ | Zoom ~ | Actions ~ | Messured values 0 | Samples/sec (target): 20 ~|| sampless 18 | Em o |
8651 | 418024 -n T T T T T T X
Massured vahie R Max 712,5 £00
R Mn 0,0 8o
- - 400
1,8 1/min = =00
1A 200
\ M e P T
¢ t t t t t t
135 140 145 150 185 160
Full screen | View = | Zoom ~ | Actions = | Measured values 0 | Samplesfsec (target): |20 - || samplers 16 | £ 0|
8661 | 418024 -P 12 T T T T T T X
Messured vahie R | Max 1.0 ok E
R Mn 0,0 s ¥ E
05 £ E|
T Tare 0,0 04+ E
J o2 i ]
0.0 t t t t t t
136 140 145 150 188 160
Full screen | View ~ | Zoom ~ | Actions + | Measured values 0 | Samples/sec (target): |20 ~|| Sampless 18 | B 0 |
Device selection >> Reset [F6] | Tara[F7] P F| ®F3| (W[ Options Qu

State: Measurement active | No measurement data logging... || II--L::

Figure 18: Display showing the measurement curves for torque, speed and mechanical power

In the Standard or Professional multi-channel software versions, you can switch between different views.

=5\
Mhis is how it works

1. Click on “full screen” to get a larger view of the measurement curve. This enlarges the
individual graph to full screen size during the measurement process.

Ml Measurement mode o X
Multi-channel display
0.5
8661 | 418024 - M R | Max 0,04
Measured value R | min 0,02 wos
T | Tere 0,00
0,01 Nm
003
004 ;
2 5 20 3 0 4
Normal | View ~ | Zoom + | Actions v | Messured values 0 | Samplesfsec {target): |20 || ssmps 16 | Em 0 |
Device selection »> Reset [F6] | | Tara [F7] » [F4] | | @ [F5] M [Fg P Options

State: Measurement active | No measurement data logaing.. | [I--Lz
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2. Click on “Normal” to revert to the standard view.

6.9 Start and stop measurement

To start a measurement with DigiVision and a connected torque sensor, follow the steps below:

3
{ /& This is how it works

1. Select the torque sensor in the device list and click “Start measurement mode...” under
“Measure” in the left-hand menu bar.

Ml pigivision - [m} X

File Edit Measure Special 7

Settings Tvpe Address Serial number Station name Mode
Device corfigurati COM10 USB Serial Port (COM10)
S EEEER 115200, 8 data bits - 1 stop bits - no party fad e
Backup
’ go61 1] SM_418024 418024
Print reports
Measure COM11 USB Serial Port (COM11)
Parameters | 551500, 8 data bits - 1 stop bits - no party ok ]
»
Start measurement
mode...
—

Find and manage
measurement repars. ..

Mizcellancous Properties Parameterization Download Find Test

|2 port(s) - with a total of 2 device(s) in the device list. Logged on as: Masterhlame (Master) .-
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Click on “Start measurement” or press [F4] to start displaying the values, or [F5] for

recording.

Ml Measurement mode

Muti-channe! display

8651 | 418024 - M 12
Messured vahe R Max -- i
R Mn -- oEF
s £
T Tare 0,00 0e ¥
LEXES
00
0
Full screen | View = | Zoom = | Actions + | Measured values 0 | Samplesfsec (target):
2661 | 418024 -n 1.2
Messured vahe R Max -- oI
R Mn -- 0FF
05+
T Tare 0,0 e
LEXS
0.0
0
Ful screen | View ~ | Zoom + | Actions = | Messured values 0 | Samplesfsec (target):
2661 | 418024 -P 12
Measured vahz R | Max -- i
R Min -- o8+
08
T  Tare 0,0 04 F
02 ¥
0.0

o
Fullscreen | View ~ | Zoom + | Actions = | Measured values 0 | Samplesfsec (target):

Device selection >>

State: Measurement not active.

During the measurement process, the instantaneous measured value and minimum
and maximum values are displayed and updated at the set measurement rate. Click
on “R” or press [F6] to reset the maximum or minimum values, “T” or [F7] to tare the

current value.

To stop measuring, click “Stop measurement” or press [F8]. Measurement can also be
stopped using a trigger with a suitable stop condition. For more information on the
trigger function, see section 6.6 Trigger on page 24.

6.10 Measurement reports

If you wish to save the raw data for the measurement data reports, before starting measurement
you must tick the “Save raw data measurement files” under “Preferences” > “Data storage”.

6.10.1 Measurement report finder

DigiVision has a convenient archiving feature for measurement reports. It lets you save all measurements
that have been made, and then retrieve them again as required. You can use the “find reports” feature to
perform the following actions for one or more reports: view, analyze, print, save as a PDF document or

export to an Excel file.
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— &
Mhis is how it works
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1. To access the report search, click on “Measure” in the left-hand menu bar and then on
“Find and manage measurement reports”.
Ml Find reports O
Find measurement report  Find group report Manual selection
Compaonent |:| Device type Date | today ~
Batch I:I Channel no. |*  « From |[02.08.23 @~
T | 02.08.23 v
Measurement date Device type Cha.. Stationname Component Batch Parts SN Min
02.08.2310:32.0% 8661 m 418024 -M 214 00001
02.08.2310:321% 8661 0 418024 -M 214 00002
02.08.23 10:32:31 2661 m 418024 -M 214 00003
02.08.2310:32:09 8661 02 418024 -n 214 00001
02.08.2310:3219 8661 02 418024 -n 214 00002
02.08.23 10:32:31 8661 02 418024 -n 214 00003
02.08.23 10:32:09 2661 03 418024 -P 214 00001
02.08.2310:3219 8661 03 418024 -P 214 00002
02.08.2310:32:1 8661 03 418024 -P 214 00003
< >
Cther path == Open all reports Open Cancel

9 measurement reports found, | 0 selected. | Path: C\Users\Public\Documents\burster\DigiVision\Data

2.

Here you have a choice of two different report types: measurement report or group
report.

A measurement report displays each individual physical variable (M, a q, P), which
are presented as one measurement sequence.

A group report is a report that contains all the measurement sequences. The individual
measurement reports that were involved in the measurement are recorded here. This
makes it easier to assign the measured variable.

Select the report type you require.

Various filters such as device type, date and channel number can be used to reduce
the number of measurement reports displayed for a clearer picture. Left-click on the
measurement report you want to select. If you want to select more than one
measurement report, hold down the [CTRL] key while selecting multiple reports.

Once you have selected the measurement reports, click “Open”.
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6.10.2 Archive viewer

Once you have selected the measurement reports from the Find reports window, the Archive viewer
opens. This gives you detailed information on your measurement. The Archive viewer is also the
management center for viewing and editing measurement reports.

Ml Archive viewer O X
Reports Data
CRC Measurement date Device type Cha.. Stationname Component Batch ] 1
OK 02.08.23 10:32:31 3651 0 418024 -M 214 General information | Measured values
oK 02.08.23 10:32.09 8661 02 418024 -n 24
OK 02.08.23 10:32:1% 8661 02 418024 -n 214 Urits 1/min
0K 02.08.23 10:32:31 8661 02 418024 -n 214 w
~ "mnnnncnnn e -~ EETEraES Start 02.08.23 10:32:31
< >
T Mumber 160
a0 T T T T T X max 10.20
¥ min 0.0
#or ] ¥ ma 3012
200 1 1 Limit 1 0.0 {0)
q Limit 2 0.0 ()
250 bl Limit 3 0.0 (0)
Limit 4 0.0 (0)

a0 T
150 ]

Coordinates X (Time) | {1/min)

] Cursor posttion /Y~ 0.3403 1.1926
] Reference poirt X/Y

Reference point A

Reference poirt B

¥ min

Y max

Delta

100

50 —+

Zoom v | Actions v Curve mode +

Export Print Quit

9 Measurement reports loaded

O,

Mhis is how it works

Figure 19: Archive viewer

1. To view each measurement report separately, left-click on the desired measurement
report.

2. To group together several measurement reports, i.e. to superimpose the measurement
curves in one graph, press the [CTRL] key while left-clicking on the measurement
reports you wish to display.

6.10.3 Export measurement reports to Excel

Note: To export the measurement reports in the Excel format you will need Microsoft Excel or an
equivalent piece of software.

Y,

Mhis is how it works

1. Once you have selected the measurement reports you click on “Export” to export an
XLS file.

Specify whether you wish to export all the reports or just those you have selected.

Specify the path to the directory in which you wish to save the file. The default setting
is to save the XLS files in the same directory as the measurement reports. You can
also specify an alternative path here.
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. Export reports >

Selection
(® Selected reports

() All reports

Output directory
[] Use special output directory

4. Click “Next”.

5. The data is converted and saved in the specified directory.

6.10.4 Print measurement reports

{ & This is how it works

1. Once you have selected the measurement reports you click “Print”.
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. Print reports >
Selection Print function
(® Selected reports (® Single page
(") Al reports () List

Color mapping measurement graph

Graphs
() Auto-zoom with limits () Bs set
(@ Auto-zoom without limits () Do not print
) Manual

— 0.000 =
SETE 301,200 =
K-ais min 0.059 -
M 10,203 =
Comment

s

2. Select how you want the measurement reports to be printed.

3. Click “Next”. The Print Options window opens.

|l Frint Options x

Print measurement reports

Export Media
= Microsoft XPS Document Writer Change...
L= Direct to... ﬁ Preview b
(f‘ Printer
Save options permanently 6, Preview
[] Adobe PDF Format
Options
First Page: =
Pages:
@al O Range(s) |
(Enter pages or ranges, separated by commas if necessary, ex.
'1,3-4,10-9
Print: all selected pages W
Copies: 1 =
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. Now specify how you want the data to be output. You have the option to choose a

printer, print preview or output as a PDF document.

5. Click on “Start”.
6. The data is output according to your settings.
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7 Installing DigiVision

7.1 System requirements

Item Manufacturer / description

Operating systems Windows Server 2003, Windows XP, Windows 7, Windows 8, Windows 10
Processor At least Pentium 1200 MHz, Pentium 2.0 GHz recommended

Graphics card At least VGA 800 x 600; at least 256 colors

Memory At least 2048 MB RAM

Hard disk Approx. 500 MB free

Input devices Microsoft-compatible mouse, standard keyboard

Font setting Small fonts

7.2 Software installation

IMPORTANT: To install DigiVision, the user needs to be logged in as an administrator.

Y,

Mhis is how it works

1. Download the latest version of DigiVision from our website and unzip the package.

2. Run Setup.exe and follow the instructions of the installation routine.

7.3 Driver installation
If DigiVision has been installed, it is not necessary to install the drivers separately. If you want to install

just the drivers, e.g. if LabView is used, please install the burster Instrument drivers. The driver package
can be found in the download area on our website.

IMPORTANT: To install the driver, the user needs to be logged on as an administrator.

7.4 Data storage

In order to be able to store the raw data from measurements carried out, you simply need to enable the
option “Save raw-data measurement files” once before starting the measurement.

Y,

Mhis is how it works

1. In the DigiVision device list, click on “Edit” > “Preferences” > “Data storage”.

2. Tick the checkbox for “Save raw-data measurement files” and click “OK”.
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' Preferences X

Intemational Data storage  Printer Securty Presentation Setting Others

Data directories

Device

|C:\Users\PubIic\Dccumems\burster\Dingon\Faram |

Save raw-data measurement files
|C'\Users\PubI|c\Dﬂcuments\burster\Dlngmn\Data

Save Excel measurement files

[ ok ]| cancel
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8  Software version and licensing
8.1 DigiVision Light

The USB torque sensor is supplied with the free DigiVision Light configuration and analysis software. This
version provides the following functions:

e Measurement function for one sensor

e Maximum sampling rate of 200 measured values per second

e Display of angle or speed (for relevant sensor model)

e Calculation of mechanical power (only with the angle or speed measurement option)

8.2 86xx-P100, Standard version

An upgrade from the DigiVision Light version to the Standard version (86xx-P100) can be purchased as
an option (license key). In comparison to the Light version, the Standard version includes the following
extra functions:

e 16-channel measurement for up to 16 sensors in parallel
e Maximum sample rate of the sensor possible

In the multichannel versions, you can switch between different views (for further details see section
6.8 Display on page 26).

O,

i@ghis is how it works
1. Click on “full screen” to get a larger view of the measurement curve. This enlarges the
individual graph to full screen size during the measurement process.
2. Click on “Normal” to revert to the standard view (see section 6.8 Display on page 26
for details).

8.3 86xx-P200, Professional version

The DigiVision Professional version (86xx-P200) is available as an upgrade for DigiVision Light or
Standard. In comparison with the Standard version, the Professional version includes the following extra
functions:

e Additional user-configurable mathematical channels.
e 32-channel measurement for up to 32 sensors in parallel

See below for an example of how to configure an additional mathematical channel. Simple calculations
such as calculating the efficiency or difference speeds and also complex mathematical operations can be
performed.

8.4 Licensing

To activate the DigiVision Standard or Professional version, follow these steps:

O,

i@l;l'his is how it works

1. In the top menu bar, click Help > Licensing.
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Ml pigivision - u] X
File Edit Measure Special | 7
Hel
Setings Tvoe v Mode
Device corfiguration Parameta Gofaxeinly Add Find
Bockan Display ReadMe
‘ ld_Geraet
Print reports [ Licensing
Measure Service >

Start measurement

Find and manage
measurement reports.

Miscelaneous Froperies Dowriead Find Test

| 1 port(s) - with a total of 1 device(s) in the device lst

Logged on as: MasterName (Master) _:

2. Enter your license key. The license key could look like this:
12345-12345-12345-12345. Make sure that you enter the license key exactly as it
appears in your license documents.

Ml Product licensing X

Registration
Licensing status of software for measurement mode

License status of devices  Agtivation code

Device type License status £

5130 unlimited license

9181 unlimited license

9163 unlimited license

9205 unlimited license

5206 unlimited license

8625 unlimited license v
To obtain an activation code, please contact us by e-mail at info@burster.de or by phoning +49 (0)7224/645-0.
New product activation

Activation code “ | = | ‘ = | | o ‘ ‘ - ‘ ‘ - | Activate License

Delete License Delete all Licenses Cancel

3. Click “Activate License”. When the correct license key is entered, the corresponding
device type is activated. If the license key is invalid, the licensing process is
terminated.

8.5 Uninstall

Follow these steps to uninstall the software: Go Start > Settings > Control Panel, open the Programs
group and select the “DigiVision” entry in the installation list. You can then uninstall the application by
selecting “Add/Remove” and “Remove program” in the installation routine.
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9 Disposal

Battery disposal

In Germany, the end user is legally obliged to return all used
batteries, and it is illegal to dispose of batteries in the household
waste. This law may also affect you as purchaser of the instrument
described here. Please dispose of your used batteries properly and
in accordance with national statutory regulations. Either take them
to the relevant collection point in your organization or to the
collection points provided by your local authority, our company or
any battery retail outlet.

Instrument disposal

If your instrument is no longer usable, please comply with your legal
obligations by disposing of the instrument described here in
accordance with statutory regulations. You will then be helping to
protect the environment!
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